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Explanation of symbols used in the manual:

This symbol denotes especially important characteristics of the software operation.
Read any information regarding this symbol carefully.

This symbol indicates additional information that may help operate the program.
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1.   GENERAL CHARACTERISTICS  
DAQ Manager software allows you to download data recorded by the MultiCon devices 

(e.g. temperature, humidity, pressure) and visualize them as tables and graphs. Data transfer 
is performed using a portable USB Flash Drive or via an Ethernet network.

2.   FIRST LAUNCH OF THE APPLICATION  
After completing the installation process, start the application from the system Start Menu 

in the folder “DAQ Manager”. From this folder you can safely uninstall the program and the 
measurement data archived up to the time of uninstalling will remain on your hard disk for later  
use.

After first launching of the program, the window shown will look like Figure 2.1.

Figure 2.1. The appearance of the interface on the first run

Explanation of elements in the figure above:

1  - Main Menu - provides access to less frequently used functions of the program;

2  - Side Menu - allows access to the main functions of the program;

3  - Devices List - contains a list of devices for which the program has archived
data or virtual devices created for communication via Ethernet;
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4  - Event Messages Area – list events occurring in the program;
Information that appears here is also saved to a file ”EventLog.txt”,
which is located in the program directory.

5  - Time Area – select the time period to create a table or graph;

6  - Report Area – view selected data in table and graph form;
Displayed measurement data can be printed or exported to *.csv file.

When you run the program for the first  time, the  Devices List is  empty because the 
program doesn't have any information about devices and their data yet. The creation of a new 
device  on the list  is  done automatically  by importing  logged data  saved on portable  flash 
memory. To add a new device you only need to import its logged data. It is possible to add a  
new device manually, which will give the possibility to import data directly from the Ethernet  
network (see section 4. ).

3.   IMPORTING DATA FROM A FLASH DRIVE  
The user can import measurement data, saved by the data logger on a portable flash 

drive, to the software database using menu [File] > [Import measurements...]. If a flash drive 
is inserted into USB port while running the program, DAQ Manager will check its contents and 
if any measurement data is find, a window is displayed to select the directory to get the new 
data.

3.1.   SELECTION OF DATA DIRECTORY  
The “Browse for Folder” window allows you to choose the folder of one device (with the  

name of the specific data logger serial number). Selecting the proper directory will activate the 
[Import]  button (Figure 3.1). Clicking on this button will start the process of importing data to 
the program database.

Figure 3.1. “Browse for Folder” window

3.2.   IMPORTING   DATA  
At the beginning of the process of importing data the program analyses the measurement 

data for changes. After that, software performs importing if it's needed. The user is informed 
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about progress of operation via a dialogue box, and should wait until the end of the process  
(when the [Close] button becomes active) as shown in Figure 3.2.

Figure 3.2. The process of data importing was completed

When the importing process was successfully completed a new device called “Device 
SERIAL_NO” (where SERIAL_NO is the serial  number of the device from which data were 
collected) appears in the Devices List.

4.   IMPORTING   DATA FROM A NETWORK  
In addition to importing data from a flash drive, you can also download logged files via an 

Ethernet network. This possibility exists only if the data logger is equipped with an advanced 
communication module with an RJ-45 socket (ACM module).

4.1.   CONFIGURING   NETWORK   SETTINGS  
To  download  the  measurement  data  and  settings  from  a  device,  connected  to  the 

Ethernet network, you must add a new undefined one to the list,  by going to the  [Devices] 
button (see section  5.  ). Then click  [Add] button. A device added to the list in this way is a 
virtual device; its serial number is undetermined yet (Figure 4.1).

Figure 4.1. Adding the new virtual device to the Devices List
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This virtual device will be equivalent to the actual real device in Ethernet network when the 
user specifies its network settings. Please check the Ethernet capabilities option, specify the 
IP address of the real device in the Ethernet network and the correct port if the device is in a  
subnet  and  is  using  port  forwarding.  Direct  communication  works  on  port  80  (http).  If  the 
network is managed by a DNS server that specifies assigned IP address to a domain name (or 
host),  then you can choose to access the device by this name,  as an alternative to an IP 
address.  This  functionality  is  especially useful  if  you want  to  use dynamic  allocation  of  IP 
addresses with the DHCP option enabled in the device. After setting the network settings, you 
can immediately test it to see whether the device responds. Please click on the [Test] button 
and read the message at the right side of it (Figure 4.2).

Figure 4.2. Example of network settings for a device that does not exist

in the network (on the left) and correctly configured (on the right)

If  the device responds correctly,  you should save these settings by clicking on the  [Save] 
button. 

4.2.   DOWNLOADING   DATA  
To download data from the preconfigured virtual device, go to the Reports section, right 

click on the appropriate device and select the [Download data] command (Figure 4.3).

Figure 4.3. Start downloading data

This will start the process of downloading the data in the form of logs and configuration of the 
device,  logged groups and channels.  The progress of  this  operation is located next to the 
device on the list. By clicking on the progress bar, you can view details of this process (Figure 
4.4).  If  DAQ Manager has  previously  downloaded  data  for  the  selected  device,  then  the 
6
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update will be made without re-downloading all logs. If during the downloading, the program 
detects any errors, the user will be informed by an appropriate entry in the Event Messages 
Area (see Chapter 2. ).

Figure 4.4. Downloading data from an Ethernet network

During  the  first  download the  serial  number  of  the  virtual  device  will  be  updated  and will  
change from virtual to real. After that, any attempt of downloading data from another device,  
e.g. after changing the IP address, will bring up the warning “Incompatible device!”.

After  completion  of  the  download  process,  you  can  choose  imported  logs,  and  then 
analyse the data and create reports (Figure 4.5).

Figure 4.5. Updated logs ready for analysis

5.   DEVICE SETTINGS  
Access to the settings of devices from which data was collected, their groups, logs and 

channels  can  be obtained by clicking  on  the  [Devices] button  in  the  Side Menu.  Certain 
settings that relate to the displaying and visualization of data, previously set in the device, can 
be changed here,  to allow for more intuitive reports.  After making changes,  the user  must 
confirm it by clicking the  [Save] button. The button  [Undo] is used to restore the last saved 
settings when an unexpected change happens.

5.1.   DEVICES  
 The number of devices on the list is unlimited. After selecting one device, the program 

displays its properties (serial number, date and time when it was added to the database and 
disk space occupied by all its data). The user can change the default name of the device and 
define the Ethernet Network settings (Figure 5.1).

7



Quick Guide for DAQ Manager software

Figure 5.1. Device settings

For convenience (e.g. to make the list more readable) each device can be hidden from 
the list of devices in the  Reports and  Current measurements sections by unchecking it on 
this list.

The user  can also  permanently remove the device from the database by selecting  a 
device and clicking the  [Delete] button.  This operation can also permanently delete all  the 
data related to the selected device, so It is strongly recommended to be very careful while  
performing this operation because there is no possibility to recover deleted data. To prevent 
against accidental data deleting, the software asks the user if all data related to device being 
removed should also be deleted from the hard drive.

The folder with databases that contain imported data is in the installation directory 
of  the program (see section  6.1.  ).  You should take care to backup its  contents 
regularly.

5.2.   GROUPS  
Each device can have up to 10 groups (depending on the settings of data logger). For 

each group the user can specify the name and description (Figure 5.2). It is recommended to 
use groups names similar to names of corresponding groups in MultiCon devices.

Figure 5.2. Group settings
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The Common scale for all channels setting is used to force the method of displaying the 
scale on the graph for creating reports as shown in the table below.

Setting Description

(default)

Individually:  Displaying  a  common  scale  setting  will  correspond 
individually for each log setting (see section 5.3).

Turned Off: The common scale for logged channels  will  be disabled. 
Each channel will  have an independent scale in the graph. Individual 
settings for each log will not be accepted.

Turned On: The common scale for logged channels will be displayed for 
each log that belongs to this group. Individual settings for each log will 
not be accepted.

5.3.   LOGS  
After expanding one of the groups, a list of logs appears (Figure 5.3). Their number is 

unlimited and depends on how often you change parameters in the data logger device, which 
causes the creation of  a new log,  and also on maximum size of  single log allowed by the 
MultiCon device.  The  name  of  the  log  contains  the  date  of  its  creation  and  completion. 
Parameters  of  each  log  are  for  information  purposes  only.  Settings  of  the  graph  and  a 
description of the log can be customized.

Figure 5.3. Log settings

The Common scale for all channels setting is used to set the method of displaying the scale 
on the graph for creating reports as shown in the table below.

Setting Description

(default)

Turned Off: The common scale for logged channels will be disabled. 
Each channel will have an independent scale in the graph.

Turned On: Logged channel values will be rescaled to a common scale 
of all displayed channels. Activating this option is useful when values of 
several channels are similar.
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5.4.   CHANNELS  
After expanding any log, a list of logged channels is shown (Figure 5.4). The user can 

specify multiple settings that affect the format of the data which is displayed in reports.

Figure 5.4. Channel settings

6.   PROGRAM SETTINGS  
Access to the program settings can be reached by clicking on the [Settings] button in the 

Side Menu.

6.1.   “APPLICATION”   TAB  
Here are the general settings of the program. The user can check the location of the data 

stored on his hard drive under Bases directory and set the interface language (Figure 6.1).

Figure 6.1. Program settings – Application tab

6.2.   “DISPLAY”   TAB  
Settings located on this tab are responsible for how data is retrieved from the archive and 

its presentation (Figure 6.2). Due to the large amount of data, user can set some limitations,  
which will shorten the waiting time to generate the report and reduce RAM usage.
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Figure 6.2. Program settings – Display tab

Enabling Omit samples mode option will cause that if during the process of creating a report  
the  user  selects  the  time  interval  which  contains  larger  amount  of  measurements  than 
specified in  Maximum number of measurements to show parameter,  the program skips 
appropriate number of samples in a way that  the amount of display measurements will  not 
exceed the limit. If Data display style is set to Real logged, values of omitted samples will not 
be included in creating a table and graph. If the Data display style is set to Average, then the 
displayed values will  include the omitted samples  as the average value. This allows you to 
detect  temporary jumps of  logged values  that  in  Real  logged style could  not  be detected 
(Figure 6.3).

Figure 6.3. Effect of display settings for graphs:

A - all samples (200 samples), B - limit without omitting (100 samples)

C – omit mode: Real logged (100 samples), D – omit mode: Average (100 samples)
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6.3.   “ETHERNET”   TAB  
Here we can find the default  settings for the Ethernet  devices (Figure 6.4), which are 

used for creating new virtual devices (see section 4.1).

Figure 6.4. Program settings – Ethernet tab

6.4.   “CURRENT MEASUREMENTS” TAB  
These  settings  concern  reading  current  measurements  in  real  time  (Figure 6.5).  The 

period of  polling devices can be freely adjusted in the range from 3 seconds to 24 hours. 
Setting  0  in  this  box will  stop  the  automatic  polling  and  then  the  current  values  are  only 
available on request.

Additional description of the current measurement settings can be found in section 9.1. 

Figure 6.5. Program settings – Current measurements tab

7.   BROWSING LOGS  
Based  on  measurement  data  collected  from devices,  DAQ Manager can  generate  a 

report as a table with all channels in the current log or in the form of graph to facilitate data 
analysis.

7.1.   SELECTION OF TIME INTERVAL  
By  selecting  desired  log  in  the  device  list,  the  program  sets  internal  time  intervals, 

computing data volume and automatically selects the last 3000 samples for displaying.
The time interval can be also defined manually by typing selected dates, or less accurate 

but faster, using the time line. Blue on the time line means there is no measurement data.  
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Gray indicates that during this period there is some measurement data, but is not selected to  
be included in the report. Orange means that the report will be generated just from this time 
interval. The orange range can be freely modified by using the mouse (Figure 7.1).

Figure 7.1. Choice of time interval

On the left and right side of the time line there are buttons that allows you to move the  
specific time period forward or backward. Automatic selection of  the time range of the last 
measurements (Figure 7.2.a) and changing the viewable region of the time line (Figure 7.2.b) 
are available from the context menu of the time line or down-arrow icon.

Figure 7.2. Contents of the context menu of the time line:

a) choice one of the predefined time ranges

b) choice one of the predefined views

After selecting a time range, the user can now generate the report as a table or a graph 
by clicking on the [Generate] button or double-click on any log on the list of devices.

7.2.   THE TABLE  
The created table consists of columns with measure number counted from the time of 

activation of  the log,  sample time (time stamp) and the data values of  particular  channels  
(Figure 7.3).

13
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Figure 7.3. Create a report as a table

If the value in the channel exceeds Low Value or High Value specified in the settings of 
the selected channel (Figure 5.4), then in the table displays “[LO]” or “[HI]” beside the value. 
However, if the channel has the setting Display Format as Binary, then instead of real value, 
a label is displayed (defined by Label ON /  OFF settings), where  Label ON is accepted for 
values greater than 0.

By pressing the  [Export to file …] button You can save the table as a CSV file 
which can then be opened with any spreadsheet program.

7.3.   THE GRAPH  
Along with the table, you can create a graph with all logged channels (Figure 7.4).

Figure 7.4. Create a report as a graph
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7.3.1.   Channel Visibility  
The legend of the graph is interactive and allows you to select channels to show and 

adjust their settings.

7.3.2.   Scaling the graph  
The scale of the graph can be changed by clicking on the time axis or the value axis and  

dragging it horizontally or vertically.
In addition, the scale of the time axis can also be changed by pressing the [Zoom In] or 

[Zoom Out] buttons. A similar effect can be obtained by pointing your mouse any location in 
the graph and while holding down CTRL key, rotate the mouse wheel.

The last method, which allows you to zoom in a portion of the graph is scaling using a 
window selection. To do this, click the right mouse button in the upper left portion of the graph, 
that you want to zoom in, then drag the selection in the direction of bottom right corner of the 
the chosen portion.

The default scale of both axes can be obtained by using the [Reset view] button.

7.3.3.   Moving the graph  
The graph can be moved by clicking on the graph and dragging it by mouse horizontally 

or vertically.
In  addition,  the  graph  can  be  moved  horizontally  by  pressing  [Move  Left] or 

[Move Right] buttons or by mouse wheel.

8.   CREATING REPORTS  

8.1.   PRINT THE TABLE  
After generating data from selected time range, the user can print the table by clicking on 

the [Print...] button at the bottom of the Table tab (Figure 8.1). This command will display a 
printer selection window, if there is more than one installed on the system.

Figure 8.1. Print the table
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If  the  printer  driver  can't  preview  pages  before  printing,  it  is  worth  thinking  of 
installing  a virtual  PDF printer  in order  to  be able to  view the printed  copy and 
prevent printing too many incorrect pages. With a large number of measurements 
printout  may consume  more  than  1300  pages  (100,000  measurements,  A4,  76 
measurements per page).

8.2.   PRINT THE   GRAPH  
The graph view specified by the user can be printed using the  [Print Graph...] button 

(Figure 8.2).

Figure 8.2. Print the graph - individual scales for channels

On the printout, there will be visible only scales of the Y-axis selected by the user and 
this is consistent with the current view.

If  the data of  several  channels  have similar  values,  then  before you print,  it  may be 
helpful to change the method of the Y-axis scaling in such a way that the scale will be common 
to all channels.  This can be done by selecting the  Common scale for all channels in the 
selected log, accessible from the [Devices] side menu (Figure 8.3)

Figure 8.3. Enabling a common scale for all channels in selected log

When you select this option, the scale of the Y-axis will be common for the checked channels  
(Figure 8.4).
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Figure 8.4. Print the graph - common scale for channels

9.   CURRENT MEASUREMENTS  
DAQ Manager allows  you  to  view current  measurements  using  an  Ethernet  network 

connection.  Users  have  two  options  for  previewing  data.  Current  measurements  can  be 
displayed in the form of a channels oriented table on the device or in graphical form as a pre-
prepared HTML page with embedded Java applets oriented on single channels of the device.

The device, which will be a source for current measurements must be equipped with 
ACM module, which enables connection to Ethernet network.

9.1.   THE TABLE  

Access to the table with current measurements is possible by clicking on the Table item 
in  Current  measurements section.  There  are  tabs  for  each  device  that  has  properly 
configured settings for network connections and the ability to view current measurements is 
set to active (Figure 9.1).

17
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Figure 9.1. Table with current measurements

If there is no a tab for the device, which measurements we want to track, then you should 
go into your device settings, check the Current measurements option (Figure 9.2) and save 
settings.

Figure 9.2. Activation of current measurements

The  polling  interval  of  devices  for  new measurements  is  adjustable  in  the  program 
settings on the Current measurements tab (section 6.4).

Current measurements mode allows you to preview the basic parameters of channels 
such as channel name, type and the current measured value with set unit. It also calculates 
the average of the measurements which occurred after the last buffer reset. For minimum and 
maximum values is also stored with the time of their occurrence, which can be displayed by 
moving the mouse cursor over the desired value.
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All values displayed in the table may be marked according to the following table:

Colour Event Description

blue A value in the table is below the graph low value, which was set in the 
device.

red A value in the table is above the graph high value, which was set in the 
device.

Access  to  the  settings  of  the  graph  thresholds  for  selected  channel  is  possible  from the 
MultiCon device as follows:

   MENU > Device configuration > Input channels > Displaying
      > Graph low
      > Graph high

If  the  display  format  is  set  to  “binary”,  then  in  the  table  the  user  will  see  the  label  
corresponding to the value of the channel.

The  [Measure] button is used to take recent data from the device without waiting for 
automatic read.

9.2.   JAVA APPLETS  
Java  applets  have  been  designed  to  read  the  current  measurements  from the  each 

channel of the selected device. They allow to visualize of the current measurements as various 
types of graphical presentation. Support for Java applets was introduced in version 2.30 of the 
device  firmware.  Before  using  the  Java  applets  functionality  it  is  recommended  that  the 
firmware of the MultiCon device be updated.

9.2.1.   Introduction  
A Java applet is a special file with the *.jar extension, which requires the Java Virtual 

Machine (JVM) to be installed on the system. Applets are designed and tested using Oracle 
JVM. To ensure, that the applets are functioning properly, an user should update the runtime 
environment of the JVM to the latest version from http://www.java.com website.

Applets can be embedded on a page of any Web server. This allows a preview of the  
current measurements from anywhere using any web browser with the Java plug-in. You can 
also design an HTML page, which will be placed locally on your hard disk. For this purpose,  
you can create a subdirectory in the installation directory of the program and put the designed 
pages there.

The HTML page should be designed in a way, that *.jar files were taken directly from the 
MultiCon devices. All devices with the ACM module contains a web server that provides the 
device information.  There is a link  “Logical  channels  graphical  view” where you can find a 
complete functional example of using Java applets embedded on HTML page.

19
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9.2.2.   The applets parameters  
When  an  applet  is  embedding  in  a  HTML document  it  is  necessary  to  let  it  some 

parameters. These parameters configure the applet to work with the selected channel of one 
device. Some of the parameters are required, which means that without giving any of them, 
the applet will not run. All parameters possible to set are shown in the table below. Their use is 
presented in section 9.2.3. 

Tab. 9.1: The applets parameters

Name Default 
value Possible values Description

device.address required IP address or 
domain name

Address of the device. This is the IP address, e.g. 
“192.168.1.97” or the correct  domain name,  e.g. 
“your.device.com”.

channel required 512, 516, ...748
1024, 1028, ...1260

Modbus  register  address  of  logical  channel 
specified in decimal format. For ease the list of all 
measurement  registers  of  MultiCon devices  is 
shown in Table 9.2.

channel.type required

logchan_float
Specifies that the value returned by the selected 
register is in the floating-point format.  By default 
for registers 512÷748.

logchan_int
Specifies that the value returned by the selected 
register  is  in  the  integer  format.  By  default  for 
registers 1024÷1260.

port 502 0÷65535 Port  of  service  running  on  the  MultiCon device 
used to handle Modbus TCP protocol.

channel.name empty any text Any name used  by  the  applet  to  represent  the 
channel.

channel.unit empty any text Any  unit  displayed  on  the  indicator  next  to  the 
current numerical value.

color BBBBFF 000000÷FFFFFF
The  indicator  color  as  RGB  sequence  given  in 
hexadecimal  format.  Selecting  the  color  helps 
http://html-color-codes.info/ page.

gauge.type text

text Type of indicator that displays the value as a text.

needle Type  of  indicator  that  displays  the  value  as  a 
needle.

hbar Type  of  indicator  that  displays  the  value  as  a 
horizontal bar.

vbar Type  of  indicator  that  displays  the  value  as  a 
vertical bar.

chart Type  of  indicator  that  displays  the  value  as  a 
graph.

range.min 0 The number in 
IEEE-754 format

Defines the minimum value is displayed. It is used 
to determine the level of 0% and lower limit on the 
Y-axis of the graph.

range.max 20 The number in 
IEEE-754 format

Defines  the  maximum  value  is  displayed.  It  is 
used to determine the level of 100% and higher 
limit on the Y-axis of the graph.

20
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The size of  the letters  in the names of  parameters and its values does not matter,  so the 
assignment "Gauge.Type"="HBar" is equivalent assignment "gauge.type"="hbar".

Tab. 9.2: Addresses of measurement registers of the MultiCon devices

Name Register Address
float int

Name Register Address
float int

Name Register Address
float int

Channel 1 512 1024 Channel 21 592 1104 Channel 41 672 1184
Channel 2 516 1028 Channel 22 596 1108 Channel 42 676 1188
Channel 3 520 1032 Channel 23 600 1112 Channel 43 680 1192
Channel 4 524 1036 Channel 24 604 1116 Channel 44 684 1196
Channel 5 528 1040 Channel 25 608 1120 Channel 45 688 1200
Channel 6 532 1044 Channel 26 612 1124 Channel 46 692 1204
Channel 7 536 1048 Channel 27 616 1128 Channel 47 696 1208
Channel 8 540 1052 Channel 28 620 1132 Channel 48 700 1212
Channel 9 544 1056 Channel 29 624 1136 Channel 49 704 1216
Channel 10 548 1060 Channel 30 628 1140 Channel 50 708 1220
Channel 11 552 1064 Channel 31 632 1144 Channel 51 712 1224
Channel 12 556 1068 Channel 32 636 1148 Channel 52 716 1228
Channel 13 560 1072 Channel 33 640 1152 Channel 53 720 1232
Channel 14 564 1076 Channel 34 644 1156 Channel 54 724 1236
Channel 15 568 1080 Channel 35 648 1160 Channel 55 728 1240
Channel 16 572 1084 Channel 36 652 1164 Channel 56 732 1244
Channel 17 576 1088 Channel 37 656 1168 Channel 57 736 1248
Channel 18 580 1092 Channel 38 660 1172 Channel 58 740 1252
Channel 19 584 1096 Channel 39 664 1176 Channel 59 744 1256
Channel 20 588 1100 Channel 40 668 1180 Channel 60 748 1260

9.2.3.   Creating HTML pages with applets   
Designing entire web sites is so wide topic,  that  cannot be described in a few words. 

However, in order to create a simple HTML document you don't have to be an experienced 
web master. You can use one of free visual editors which generate right HTML code. May be 
required  some minor  changes  only.  More complex  pages  may require  help  from the  web 
master. Nevertheless, even the most complex HTML pages, a web master can made in a few 
hours.

There are a lot of visual editors that allow to build more or less complex HTML pages.  
One of the best free solution is the Microsoft product named Office SharePoint Designer 2007, 
which can also be used for commercial  purposes. Creating a simple HTML page with this 
program using the WYSIWYG method is very intuitive and the generated code is quite optimal.

To create a simple web page generally you should follow three steps:

I. Prepare  a  drawing  (a  layout)  or  take  a  photo  of  the  monitored  room (object  or 
system)

II. Create a web page using the image file created in step I.
III. Embedding an applet in the selected location of the page and set its parameters
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USING A VISUAL EDITOR 

Below  is  shown  an  example  of  these  steps  with  SharePoint  Designer  2007  using 
WYSIWYG technique.

1) Prepare of the image file
Creating  a  background  image  is  not  necessary,  but  improves  orientation  in  the 
monitored system. To create a room plan, you can use any raster graphics editor and 
saving the file in one of the formats: *.png, *.jpg, *.gif. Instead of creating a plan, a 
good solution is to take a photo of the real object on which indicators will be placed. 

2) Create a HTML document 
Main window of the SharePoint Designer 2007, just after start looks like in Figure 9.3.

Figure 9.3. Main window of the SharePoint Designer 2007

Main window contains already an empty HTML document,  which must be given a 
name and must be saved. To do this, select command [File] > [Save As...] from the 
menu. In the dialogue box should be given a title of the document by clicking on the 
[Change title...] button, then select the location and enter file name (Figure 9.4). If 
the page will be stored locally on your PC, it is recommended to create a subdirectory 
with  the  name  of  the  monitored  system  in  the  subdirectory  of  DAQ Manager 
installation folder named “AppletSites”,  which is intended for HTML pages. For the 
current  example  the  location  is  C:\Program Files\DAQManager\AppletSites\ 
ChemLab\chemlab_en.htm.
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Figure 9.4. Giving a title and saving the page to the disk

3) Division of the document to the header and the indicators area 
The document in the example will be composed of two parts: a header and area of 
indicators.  This  division  obtains  using  the  table.  To do  this,  select  the  [Table] > 
[Insert Table...]. In the window that appears, set the following parameters:

Rows: 2
Columns: 1
Alignment: Center
and uncheck Specify width

4) Prepare of the header
In the first row of the table, enter a name of the system which will be monitored, such 
as “Chemical Laboratory”. Then click on the icon of the text alignment [Center] and it 
will  create a new style named “.style1”.  Change its name to “header”.  To do this, 
switch to the  [Manage Styles] tab and select  [Rename class “style1”...] from the 
context menu of the new created style (Figure 9.5).

Figure 9.5. Changing the style name
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To improve the appearance of the header you should perform a few modifications to 
its style. Click the command [Modify Style...] on its context menu. Window “Modify 
Style” appears (Figure 9.6).

Figure 9.6. “Modify Style” window

In the window you can see that the style has already set a property:  Block >  text-
align: center. You need to modify the following properties:

Font > font-family: Arial, Helvetica, sans-serif
Font > font-size: 30 pt
Font > font-weight: bold
Box > padding: bottom: 15 px

and click OK.

5) Prepare of the indicators area 
Take a <div> tag from the toolbox and drag to the second row of the table (Figure 
9.7).

Figure 9.7. Dragging the tag from the toolbox.

Then click  on the  arrow next  to  the  <div> tag on  the nesting  bar  and select  the 
command [Positioning] > [position: relative] (Figure 9.8).

Figure 9.8. Creating a new layer from the <div> tag
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After this operation the <div> tag will be converted to a layer, which you can name. To 
do this, switch to the [Layers] tab. If this tab is not visible, you must first enable it by 
using the [Format] > [Layers...] command. Right click on the layer <No ID> and go 
to  [Modify ID...],  and  then  enter  the  name “background”.  Created  layer  will  be  a 
container for background image and for applets that will be positioned relative to it.

6) Inserting a background image
Click in the area of the second row of the table, so the label “div#background” should 
appear. Insert the prepared background image by using the menu [Insert] > [Picture] 
> [From File...]. At the prompt to enter alternative text you can uncheck the box next 
to it (Figure 9.9).

Figure 9.9. Confirmation of inserting a picture

7) Embedding an applet
To add  a  Java  applet  into  the  prepared  site,  click  somewhere  on  the  previously 
inserted image and press the right arrow key to move the cursor next to the picture. 
Then  choose  a  command  from  the  menu  [Insert]  >  [Web  Component...] > 
[Advanced Controls] > [Applet Java] and click [Finish]. You will see a “Java Applet 
Properties” window. In the Source applet field please enter:

jmulticon.gauge.McGaugeApplet.class

Then add required parameters of the applet (see section 9.2.2. ):
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Name Value
device.address IP address or domain name

channel 516
channel.type logchan_float

You can also specify additional parameters that are not required, but allow you for 
adjust of the indicator properties. Parameters that are omitted have default values:

Name Value Default value
port 502 502
channel.name Temp. empty

channel.unit °C empty

color FF6600 BBBBFF
gauge.type needle text
range.min 0 0
range.max 30 20

Window of the applet properties is shown in Figure 9.10.

Figure 9.10. Defining a new parameter of the applet

When you finish, set the parameters and click OK. You must still specify the source 
location from where the applet will be downloaded to the web browser. Each device 
that is equipped with the ACM module contains applets, which can be accessed using 
the http protocol. To specify the source location of the applet, select the applet in the 
design window and in the  [Tag Properties] tab, in the  archive attribute write value 
http://ADDRESS/channels/jmulticon.jar,  where  ADDRESS is  the  IP  number  or 
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domain assigned by the DNS server (Figure 9.11).

Figure 9.11. Specifying the source location of the applet 

The applet is ready to run, but still needs to be positioned on the page.

8) Changing the position of the applet 
To change the position of the applet relative to the background image, click on the 
arrow  next  to  the  <applet>  tag  on  the  nesting  bar  and  select  the  command 
[Positioning] >  [position:  absolute] (Figure 9.12).  This  operation  allows  you  to 
move the applet freely around the page area and its position will always relative to the 
previously created “background” layer.

Figure 9.12. Activation the possibility to move freely the applet
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By grabbing the “applet” label, you can move it anywhere in the background. With the 
special holders you can also adjust the size of the applet (Figure 9.13).

Figure 9.13. Changing the position and size of the applet

9) Duplicate the applets
The easiest way to create another applet on the page, which will represent another  
logical channel of the specified device is to copy an already existing applet and adjust 
its parameters. To do this, right-click on an existing applet and select  [Copy], then 
right-click on the background image and select [Paste]. This will create a new applet 
on the top of existing one. The new created applet can be moved to a new position by 
its label. Adjust its parameters can be done by double-clicking on its surface.

If the above steps have been completed and the page was saved, the project is ready to 
run using a web browser. This can be done directly from the SharePoint Designer from the 
menu  [File] >  [View  in  Browser] >  [Windows  Internet  Explorer] or  use  the  keyboard 
shortcut F12.
If the IP address identifies the device, which is turned on and is currently in the network, that  
on the page in a web browser should show a fully working applet (Figure 9.14).

Figure 9.14. Ready web page with the working applet
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As you can see, create a simple web page with a single applet is not so difficult, even for 
a person who had no contact with the HTML language, before. However, basic knowledge of 
this language is useful for creating more complex pages.

USING A TEXT EDITOR 

Steps to create an HTML document  in a visual  way caused to generate some HTML 
code. User more familiar with creation of the web sites probably wants to use the possibility to 
directly intervene to the HTML code, as this gives greater control of its appearance. To display 
HTML code in the SharePoint  Designer,  click the  [Split] or  [Code] button in the lower left 
corner of the project. Created code should be similar to the following.

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" 
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">
<html xmlns="http://www.w3.org/1999/xhtml">
<head>
<meta http-equiv="Content-Language" content="en" />
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<title>Chemical Laboratory</title>
<style type="text/css">
.header {
  text-align: center;
  font-family: Arial, Helvetica, sans-serif;
  font-size: 30px;
  font-weight: bold;
  padding-bottom: 15px;
}
</style>
</head>
<body>
<table align="center">
  <tr>
    <td class="header">Chemical Laboratory</td>
  </tr>
  <tr>
    <td>
      <div style="position: relative" id="background">
        <img src="res/lab_scheme.png" width="530" height="464" />
        <applet code="jmulticon.gauge.McGaugeApplet.class"
         archive="http://192.168.1.97/channels/jmulticon.jar"
         style="z-index: 1; position: absolute;
         top: 338px; left: 132px; width: 166px; height: 101px">
          <param name="device.address" value="192.168.1.97" />
          <param name="channel" value="516" />
          <param name="channel.type" value="logchan_float" />
          
          <param name="port" value="502" />
          <param name="gauge.type" value="needle" />
          <param name="channel.name" value="Temp." />
          <param name="channel.unit" value="°C" />
          <param name="color" value="FF6600" />
          <param name="range.min" value="0" />
          <param name="range.max" value="30" />
        </applet>
      </div>
    </td>
  </tr>
</table>
</body>
</html>
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The page that looks like this could be a template for further development for other monitoring 
systems. It may also be the base for duplicate indicators by copying the code one of them, 
change its parameters and set it to the correct position. Part of the code, which is responsible  
for the appearance and behaviour of the indicator was marked in purple.

9.2.4.   Access to the applets from the software  

Clicking on the  [Applets] button in the  Current measurements section will display the 
interface for managing Java applets (Figure 9.15). At the beginning, the list of pages contains 
only the item “[Demo Site for Device 1]”. After designing a page you can add it to the program 
by entering the correct URL address or a path to a local file. Paths to files can be defined as 
relative to the installation directory of the program. This allows for easy transfer all pages, in 
the future, to a new installation directory.

Figure 9.15. The interface for managing pages with Java applets

For more advanced users in creating web pages there is a possibility to transfer several 
parameters directly from the program to the page that could interpret them. If the page is on a 
server with PHP, ASP or other scripting language, that can process received parameters using 
GET method and on this basis generate an HTML document, you can design your site more 
universal. Read the current measurements by indicators placed on the page can be done from 
devices with different IP addresses. When the IP address will change in one of the device on 
the  DAQ Manager list,  web  master  no  longer  needs  to  modify  sources  of  the  web  site,  
because information about the current IP address may always be passed as a parameter of 
the URL. The script allows the interpretation of transmitted parameters even doesn't need to 
be placed on the server side.  This interpretation can be done on the client  side in a static  
HTML document using JavaScript. As example realization of such concept is an entry “[Demo 
Site for Device 1]”, which is a reference to the demonstration site built-in to the DAQ Manager 
since version 1.3.1. List of all variables that can be used in the URL are in the table 9.3.
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Tab. 9.3: List of variables for use in URLs
Variable Description

{LANG} Language of the program interface according to ISO 639-1.

Example:  The  entry  {LANG} will  be  replaced  by  “en”  if  the 
interface is in English.

{DEVn_par} The parameter of the n-th device on the list.
Part par may have the following values:

• NAME – the name of the device
• SERIAL – the serial number of the device
• IP – the IP address or domain name of the device
• PORT – the HTTP server port on the device

Example: The entry {DEV2_IP} will be replaced by the IP address 
of the second device on the list, for example by “192.168.1.98”.

{SERs_par} The parameter of the device from the list, which serial number is 
equal to s.
Part par may have the following values:

• NAME – the name of the device
• IP – the IP address or domain name of the device
• PORT – the HTTP server port on the device

Example: The entry {SER1010P0909_IP} will be replaced by the 
IP address of the device from the list, which serial number is equal 
to 1010P0909, for example by “192.168.1.97”.

The size of the letters in the names of the variables does not matter, so the  {Dev4_Name} 
entry is equivalent to {DEV4_NAME}. 

9.2.5.   Running the selected HTML page  
To view the selected page from the list,  double-click on its name. This action opens a 

dialogue with the designed web page. When you run a page with applets for the first time, the 
program prompts you for confirmation to run the applets. Please check Always trust content 
from this publisher option and click the [Run] button (Figure 9.16).

Figure 9.16. Confirmation to run Java applets
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9.2.6.   Window with a HTML page  
When the page with the applets is fully loaded and the applets connected to the devices, 

the user will have the ability to view measurements in real time. The right side of the window 
contains the most commonly used operations to help manage the preview window (Figure 
9.17). You can scale the page, automatically adjust the size of the window and bring to front 
the main window. Additional commands can be found in the context menu of the page.

Figure 9.17. A window with a sample HTML page

The default  appearance of  the indicators  is defined on the design level  of  the HTML 
page. The context menu for each indicator allows temporary changes of its appearance and 
provides additional commands for its handling.

If the user does not have a web page designed to his needs, he may use the universal 
view of all channels taking a page directly from the MultiCon device, which is mentioned in the 
section 9.2.1.  Examples of URLs for this case could be found on Figure 9.15 under the name 
“MultiCon Direct”. A web page with indicators taken directly from the device makes it possible 
to view all of its channels and allows easy change of the display mode (Figure 9.18).
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Figure 9.18. Web page with indicators from the device

9.2.7.   Automatic arrangement of windows  
If  user opens too many applet  windows and they overlap,  it  will  be helpful  to use the 

[Windows  arrangement] button,  which  is  located  in  the  upper  part  of  the  applets 
management interface. For example, if you open seven windows that overlap, they can quickly 
spread out in a 4x2 grid (Figure 9.19).

Figure 9.19. Automatic arrangement of windows in a 4x2 grid
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System requirements:
- Operating system: Windows XP (32-bit) or later 
- processor Pentium/AMD 600 MHz or faster
- 128 MB of RAM or more
- 2 GB or more free disk space
- monitor with min. resolution SVGA (800x600)
- CD-ROM or DVD-ROM
- network card
- keyboard and pointing device (e.g. mouse)
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